Essentials of Strength Training and Conditioning Presentation Package, Fourth Edition

User Instructions
Credits


Copyright © 2016 by Human Kinetics, Inc. Microsoft® PowerPoint® copyright © 1987-2010 by Microsoft Corporation. All rights reserved. Windows is a registered trademark of Microsoft Corporation. Microsoft is a registered trademark of Microsoft Corporation. The reproduction of this software is forbidden without the written permission of the publisher. Instructors and agencies that have either purchased Essentials of Strength Training and Conditioning Presentation Package, Fourth Edition, or received it free upon adopting the textbook may display the slides and images it contains in a classroom setting, or include them in handouts to students, without further permission from Human Kinetics, as long as the images are used in conjunction with the textbook.

All figures, tables, and photos included in this presentation package are reprinted, with permission, from NSCA, 2016, Essentials of Strength Training and Conditioning, Fourth Edition, edited by G. Haff and T. Triplett, unless otherwise noted.

Permission notices for material reproduced in this presentation package from other sources can be found on the Credits page of the How to Use the Presentation Package file.

Acquisitions Editor: Roger W. Earle; Consultant: Courtney Goodman; Developmental Editor: Christine M. Drews; Managing Editor: Karla Walsh; Copyeditor: Joyce Sexton; Permissions Manager: Dalene Reeder; Graphic Designer: Nancy Rasmus; Photographs: Neil Bernstein, © Human Kinetics; Photo Asset Manager: Laura Fitch; Visual Production Assistant: Joyce Brumfield; Photo Production Manager: Jason Allen; Art Manager: Kelly Hendren; Associate Art Manager: Alan L. Wilborn; Art Style Development: Joanne Brummett; Illustrations: © Human Kinetics, unless otherwise noted

Minimum System Requirements

Microsoft® Windows®
- Windows® 2000/XP/Vista/7
- Microsoft® PowerPoint® 2003 or higher
Macintosh®
- Mac OS X 10.x
- Microsoft® PowerPoint® for Mac 2004 or higher

This presentation package is an ancillary to the textbook Essentials of Strength Training and Conditioning, Fourth Edition, published by Human Kinetics. If you need technical support for the Essentials of Strength Training and Conditioning Presentation Package, Fourth Edition, please call 217-351-5076 Monday through Friday (excluding holidays) between 7 a.m. and 5 p.m. (CST). Or, e-mail us at support@hkusa.com.

When you call or e-mail, please provide the following information:
- The type of hardware you are using
- The version of the software you are currently using
- The exact wording of error messages or the message numbers appearing on screen
- A complete description of what happened and what you were doing when the error message appeared
- An explanation of how you tried to solve the problem

Human Kinetics
End User License Agreement

NOTICE TO USER:

The installation and use of this product indicates your understanding and acceptance of the following terms and conditions. This license shall supersede any verbal, or prior verbal or written, statement or agreement to the contrary. This Human Kinetics End User License Agreement accompanies a Human Kinetics software product and related explanatory written materials (“Software”). The term “Software” shall also include any upgrades, modified versions, or updates of the Software licensed to you by Human Kinetics. If you do not understand or accept these terms, or your local regulations prohibit “after-sale” license agreements or limited disclaimers, you must cease and desist using this product immediately. Copyright laws supersede all local regulations.

Liability Disclaimer
This product and/or license is provided exclusively by Human Kinetics on an “as is” basis, without any representation or warranty of any kind, either express or implied, including without limitation any representations or endorsements regarding the use of, the results of, or performance of the product, its appropriateness, accuracy, reliability, or correctness. The entire risk as to the use of this product is assumed by the user and/or licensee. Human Kinetics does not assume liability for the use of this product beyond the original purchase price. In no event will Human Kinetics be liable for additional direct or indirect damages including any lost profits, lost savings, or other incidental or consequential damages arising from any defects, or the use or inability to use this product, even if Human Kinetics has been advised of the possibility of such damages.

Restrictions
You may not use, copy, modify, translate, or transfer the product or any copy except as expressly defined in this agreement. You may not remove or modify any copyright notice, nor any “about” dialog or the method by which it may be invoked.

Operating License
You have the non-exclusive right to use the product only by a single person, on a single computer at a time. If the product permits, you may physically transfer the product from one computer to another, provided that the product is used only by a single person, on a single computer at a time. In group projects where multiple persons will use the product, you must purchase an individual license for each member of the group. Use over a local area network (within the same locale) is permitted provided that the product is used only by a single person, on a single computer at a time. Use over a wide area network (outside the same locale) is strictly prohibited under any and all circumstances. Any violation immediately cancels all distribution rights.

Backup and Transfer
You may make one copy of the software part of the product solely for backup purposes, as prescribed by Canadian, United States, and international copyright laws. You must reproduce and include the copyright notice on the backup copy. You may transfer the product to another party only if the other party agrees to the terms and conditions of this agreement and completes and returns registration information (name, address, etc.), including a signed license, to Human Kinetics, Inc. within 30 days of the transfer. If you transfer the product you must at the same time transfer the documentation and backup copy, or transfer the documentation and destroy the backup copy. You may not retain any portion of the product, in any form, under any circumstance.

Terms
This license is effective until terminated. You may terminate it by destroying the complete product and all copies thereof. This license will also terminate if you fail to comply with any terms or conditions of this agreement. You agree upon such termination to destroy all copies of the software and of the documentation, or return them to Human Kinetics for disposal.

Other Rights and Restrictions
All other rights and restrictions not specifically granted in this license are reserved by Human Kinetics.

Human Kinetics

United States: Human Kinetics
P.O. Box 5076
Champaign, IL 61825-5076
217-351-5076
e-mail: humank@hkusa.com

Canada: Human Kinetics
475 Devonshire Road Unit 100  
Windsor, ON N8Y 2L5  
519-971-9500  
e-mail: info@hkcanada.com

Europe: Human Kinetics  
107 Bradford Road  
Stanningley  
Leeds LS28 6AT, United Kingdom  
+44 (0) 113 255 5665  
e-mail: hk@hkeurope.com

Australia: Human Kinetics  
57A Price Avenue  
Lower Mitcham, South Australia 5062  
08 8372 0999  
e-mail: info@hkaustralia.com

New Zealand: Human Kinetics  
P.O. Box 80  
Mitcham Shopping Centre, South Australia 5062  
0800 222 062  
e-mail: info@hknewzealand.com

E6373
Presentation Package User Instructions

The *Essentials of Strength Training and Conditioning Presentation Package, Fourth Edition*, has more than 1,300 slides. These slides contain most of the art, tables, and content photos from the textbook as well as text slides highlighting the book’s most important concepts. You can add, modify, or delete slides as you see fit. By using the Outline view on the left navigation bar, you can see the slide titles to quickly identify what is included in each file and select the slide you want to use. The order of the figures, tables, and content photos in the presentation package matches the order of those same items in the book.

Using the Presentation Package

The following are instructions for some common tasks you might want to perform within the presentation package and assume you are working in PowerPoint 2010.

*Note: To manipulate the presentation content, you must have the full version of Microsoft PowerPoint 97 or higher.*

**How to Delete a Slide**

1. Use the full version of Microsoft PowerPoint to open the chapter file that you wish to delete a slide from. Select “Normal” from the “View” menu.
2. In the left navigation bar, in the “Slides” tab, click the slide you want to delete. The slide will be outlined in yellow.
3. Press the Delete key. The slide will be deleted. If you delete a slide by mistake, select Ctrl + z to undo the deletion.

**How to Edit an Existing Slide**

1. Use the full version of Microsoft PowerPoint to open the chapter file where you wish to edit a slide.
2. Select the slide you wish to edit and put your cursor wherever you want to adjust text.
3. Edit however you like. PowerPoint will automatically adjust the spacing and scale of subsequent items to fit the space on the slide.

**How to Add a New Slide**

1. Use the full version of Microsoft PowerPoint to open the chapter file where you wish to add a new slide.
2. To add a regular content slide, choose “Insert,” from the toolbar menu, then “New Slide.” A sidebar with slide layout options will appear. You can simply close this sidebar, or select one of the “Text Layouts” to further customize the slide. [In PowerPoint 2010, add a regular content slide by clicking on the Home tab and clicking on the New Slide button. From there slide type options will appear and you choose the slide type you wish to add.]
3. To add a chapter opener slide, click once in the left navigation bar (in the “Slides” tab) on the chapter opener slide. The slide will be outlined in blue. Choose “Insert” from the toolbar menu, then “Duplicate Slide.” A copy of the slide will be created. Use the instructions under “How to Change the Order of Slides” to move the slide to your desired location. [To add a chapter opener slide in PowerPoint 2010, click once in the left
navigation bar (in the “Slides” tab) on the chapter opener slide. The slide will be highlighted. Go to the Home tab, click the New Slide button, and then at the bottom of the popup box you’ll see an option called “Duplicate Selected Slides.” Click that line to copy the chapter opener slide. Use the instructions under “How to Change the Order of Slides” to move the slide to your desired location.]

How to Change the Order of Slides
1. Use the full version of Microsoft PowerPoint to open the chapter file where you wish to reorder the slides. Select “Normal” from the “View” menu.
2. On the left navigation bar, in the “Slides” tab, click on the slide you want to move. The slide will be highlighted.
3. Press Control (Ctrl)-X. (For Mac users: Press Command-X.)
4. On the left navigation bar, click once in the new location where you want the slide to go. You can click between slides in the place you want the slide to go, or on the slide that precedes the place you would like the slide to go.
5. Press Control (Ctrl)-V to paste the slide in the spot you have selected. (For Mac users: Press Command-V.)

How to Print Slides
1. Go to File/Print and select the options that best fit your needs.
2. If you notice that your black and white printer is printing white font as black font, go to File/Print and change “Grayscale” to “Color.”
Credits

Figure 2.5

Figure 2.10

Figure 2.13

Figure 4.5

Figure 4.7

Table 5.3

Figure 7.2

Figure 8.1

Figure 8.2
Figure 8.3

Figure 9.1
From USDA’s Center for Nutrition Policy and Promotion.

Table 9.2

Table 9.3
From Institute of Medicine (US).

Table 9.5

Figure 11.2

Figure 13.5

Figure 13.6

Figure 13.11

Figure 13.12

Figure 13.16
Figure 17.2

Figure 18.1

Figure 18.2

Figure 19.3

Figure 19.5

Table 19.5

Table 20.2

Figure 21.1

Figure 21.2
Figure 21.3

Figure 21.4

Table 23.1

Table 24.2
Adapted, by permission, from NSCA, 2011, Performance training center emergency policies and procedures manual (Colorado Springs, CO: NSCA), 3.